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(1) Overview

The Mass Balance Summary is a user-defined hierarchy of series slot collections used to check mass balance across many objects in a RiverWare
model. Any data object can optionally have a Mass Balance Summary definition. Series slots representing sums of the sets of series slots are
maintained on the data object, and can be referred to from Rpl expression slots defined by the user for any summation calculations not provided by
the Mass Balance Summary, e.g. annualization of sums.

(1.1) Reference Model

The Mass Balance Summary design was derived from a Rpl expression slot-based implementation by the URGWOM (Upper Rio Grande Water
Operations Model) team [a version of "MRGV 2011 calibration"]. This particular mass balance calculation involved about 160 Rpl expression slots
to sum about 560 physical series slots. Data from this URGWOM model was used to demonstrate this GUI design.
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(2) User Interface and Functional Design

(2.1) Mass Balance Summary Structure

A Mass Balance Summary ("Summary") can be associated with any data object. The configuration of the Summary is saved with the data object in
RiverWare models and in data object (simulation object) export / import files.

Primary Configuration Data:

Four level-hierarchy of Series Slot references:

Level Slot Type Color

1 Water Balance Groups Series Slots Pink

2 Water Balances Agg Series Slots Cyan

3 Slot Groups (+/-) ... child Series Slots Yellow

4 Slots Series Slot References Green

Each Slot Group will be summed as a Credit ("+") to, or Debit ("-") from its
containing Water Balance.

The set of generated series slots (and aggregate series slots) used to represent
sums in the top-three levels is automatically maintained. The values of these
slots will be computed internally with a C++ implementation (rather than with Rpl expression slots). They will be "read-only" -- their values will not
be editable by the user.

The lowest level -- references to series slots in the model -- can include references to user-defined Rpl expression slots to compute terms which are
not directly available as RiverWare slots at the same timestep. The reimplementation of the URGWOM mass balance calculation using Mass
Balance Summaries may need:

Three (3) Rpl expression slots to shift data one timestep, for routing.
Six (6) Rpl expression slots to calculate a "change in storage" from the prior timestep. [We may choose to support this entity as a new physical
series slot].

Other Configuration Data:

Flow / volume display unit selection, and other minor display settings.
Generated slot name preferences.
A list of user-defined Rpl expression slots dependent on the computed Summary series slots. Each time the Summary is recomputed, the slots
in this list will also be recomputed, in the list order. One possible use of the "Dependent Expression Slots" list is the computation of annual
mass balance series data.
A list of simulation objects associated with each Water Balance to constrain the set of slots assigned to the Water Balance's Slot Groups.

(2.2) Mass Balance Summary Evaluation

Each "computed sum" series slot -- the items in the first three levels -- is the sum of all the contained items (series slots) at each timestep -- with
debit (negated) terms supported at the Mass Balance level. The time range of a computed slot is the extrema of time ranges of the contained items.

The particular times of Summary recomputation will depend on the performance of the calculations (TBD). In any case the following events will
result in either performing the computation OR visually marking the Summary display as "dirty" (needing a recomputation):

The "Recompute" button in the Mass Balance Summary dialog is clicked.1.
A run stops (TBD: unconditionally OR only in batch mode or if the Mass Balance Summary dialog is open).2.
The Mass Balance Summary dialog is opened.3.
Relevant Mass Balance Summary configuration changes are applied by the user.4.

Before a Summary recomputation, any "missing" generated series slots are created on the data object, and "orphaned" series slots (i.e. previously
created summation series slots which are no longer used, e.g. as a result of an item name change) are destroyed. These series slot maintenance
adjustments will be performed also as a result of certain edits to the Summary configuration.

After each Summary recomputation, the "dependent" Rpl expression slots in a user-configured ordered list are evaluated. Read more in the
configuration section, below.
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(2.3) Accessing Water Balance Summaries

A Water Balance Summary can be created on any data object with the "Add Mass Balance
Summary..." operation in the Open Data Object dialog's "Edit" menu. This shows the Mass Balance
Summary dialog in its configuration mode.

A data object having a Mass Balance Summary is indicated in the object type description (see below).
When a Summary exists, a "Mass Balance Summary..." item appears in the Open Object Dialog's
View menu. (And the "Add ..." item in the Edit menu is changed to "Mass Balance Summary..." as
well).

Possible Enhancements:

Add a button (maybe a small icon button) to the Open Object Dialog to open an existing Mass
Balance Summary on the data object.

1.

Devise a modification to the Data Object icons to indicate that the data object has a Mass
Balance Summary.

2.

Already existing Summaries are accessible from the Workspace menu in the
RiverWare Workspace.
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(2.4) Mass Balance Summary Dialog

The Mass Balance Summary dialog is accessible from the Workspace menu and
from the Open Data Object dialog (see above).

Clicking the data object icon button at the top of the dialog shows the Open
Object Dialog for the data object containing the Mass Balance Summary. This
provides access to the automatically generated Summary summation series slots.

The four supported levels of summation sets are represented with color-coded
buttons -- clicking these buttons results in opening up the tree view to the
particular level.

Water Balance Groups1.
Water Balances2.
Slot Groups3.
Slots (references)

This screenshot shows the result of clicking the "Water Balances" (level 2)
button.

4.

Subtrees can also be opened and closed in the normal way, with the tree controls.

The integer shown to the left of the level buttons indicates the number of defined
items at that level. For example, the screenshot shows that this Summary contains
6 Water Balance Groups, 19 Water Balances, 137 Slot Groups, and 560 Slot
references.

Each line in the tree view represents a "computed sum" series slot or a referenced
series slot (in the case of the fourth level). Context menu operations on the set of
selected lines include:

Plot the selected slots.
Show the selected slots in Open Slot dialogs.
Show the selected slots in a new SCT.
Add the selected slots to an open SCT.

Possible Enhancements:

Devise heuristics, possibly using user configurable preferences, for distributing multiple selected items among distinct plots (up to 9) within
a single plot page.

1.

Support for "Stacked Area" Plots: a new type of plot where the ordered set of series slots are shown with accumulated values -- i.e. added to
the values of the previous series slots in the list. (This would work well for groups of series where all the values are positive "credits" to the
overall sum).

2.

Tree view data columns show data in the selected Flow or Volume slots, with user-selected units.
The illustrated Volume and Flow units (to the right) are supported for numeric series data display
-- as defined in the currently available standard RiverWare "units" file.

The following data columns are supported:

Value (at the selected timestep)
Minimum value in the defined time series*
Maximum value in the defined time series*

*conditionally hidden or shown, based on a configuration setting.

Numeric summation data is shown only for the item levels with a checked "values" checkbox to
the right of each level button -- see below. This allows the user to quickly scan through similarly
"scoped" sums (e.g. only Slot Group sums).
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Possible Enhancement: Add buttons along the bottom of the Mass Balance Summary dialog, mostly for operations which apply the the selected set
of items.

Plot
Open Slots
Show in SCT
Add to SCT
Close

Above: Water Balance Groups (level 1).

Right: Slot Groups (levels 1, 2 and 3).
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(2.5) Mass Balance Summary Dialog Menus

The Mass Balance Summary Dialog supports a "File" and "View" menu.

TBD: The "Export" and "Import" operations will be used at least for development testing of the
Summary configuration serialization. We might not choose to support this in the final implementation.
Note that a data object's Mass Balance Summary configuration will be included in the SimObj "export"
file for the data object.

Two types of columns will optionally be shown, based on checkboxes in the "View" menu:

Abbreviation column (used for the names of generated summation slots).
Series Min/Max Values column.

The "View" menu will also support an "Adjust Columns" operation, which fits the width of each column
to the width of the content of that column.

The tree view context menu ("right-click" menu) operates on the full set of selected items:

(2.6) Mass Balance Summary Configuration

When the Mass Balance Summary dialog's "Configure" group box toggle is checked, the following occurs:

Several tabs of configuration controls are shown in the "Configure" group box -- See below.
"Move Items" arrow icon buttons appear below the tree view. The Move Items operations function only to reorder items within their
containing items -- not move them to different containing items. These buttons are enabled only when the item selection is limited to items
within a single level and that selection doesn't already include the top-most or bottom-most item in its respective group.
Item names are editable (inline).
Item abbreviations are editable (inline), if the abbreviation column is shown. Item abbreviations are used for the names of generated
summation series slots.

The "Edit Operations" Configuration Tab provides context-
sensitive edit controls for the first three item levels. (The
enabledness of each item depends on the item selection within the
tree view). Some of these operations are also available in the tree
view context menu.

"New": Creates a new instance at the indicated level with a
default name. An item is created and an incell edit is started
on that default name. A New Water Balance Group (top level)
item can always be created. The "New" operations for the
subsequent two levels is enabled only if a single containing
item at the appropriate level is selected within the tree view.
"Copy": This operation is available only if the selection is
limited to a single level. It copies the selected items -- including those items' children -- to a special clipboard for items at that level. This
operation also has the following side effects:

The series slots for the selected items are copied to the RiverWare slot clipboard.a.
The names of those slots are copied to the system clipboard (as plain text).b.

"Paste": This operation is available only if a single item is selected AND the special clipboard for that item's level contains copied items. The
Copy/Paste operation includes all of the child items in the original copied selection. Copying and pasting is supported between distinct Mass
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Balance Summaries (on distinct data objects).
"Delete": Deletes the selected items, with a confirmation dialog box.

Additionally, there are the following buttons for Slot Groups:

(+) and (-) icon buttons: Sets the selected Slot Groups to either Credits or Debits.
"Configure...": Opens the Mass Balance Slot Group Configuration dialog for the single selected Slot Group. (See below).

The "Slot Generation" Configuration Tab provides settings for
names given to the automatically generated summation slots -- for
items in the top-three levels. These settings are intended to address
these two issues:

It should be easy to distinguish the automatically generated
series slots from other slots the user has placed on the data
object.

1.

Slot names generated from the multiple levels of item labels
would be quite long. It would be best if the user had the
option of using shorter strings for each item when generated
slot names.

2.

By default (as illustrated), a prefix of "mb_" is used for generated
slot names. The user has the option of omitting that prefix or specifying a different one -- individually for the Water Balance Groups (level 1) and
Water Balances (level 2). Note that the series slots of Slot Groups (level 3) will be child "columns" of the Water Balance aggregate series slots -- no
prefix will be prepend to the column labels for those series slots.

The "Abbreviation Column" is conditionally shown within the tree view, based on a checkbox in the View menu. Clicking the "Show Abbreviation
Column..." button turns that checkbox on and shows the abbreviation column. Text in the abbreviation column is directly editable (inline) only
when the "Configure" group box is open (checked on).

The "Dependent Expression Slot" Configuration Tab provides a
user-defined ordered list of Rpl expression slots which should be
automatically evaluated at the conclusion of the Summary
recomputation.

The example to the right enumerates annualization Rpl expression
slots in the URGWOM reference model. These would be recoded to
refer to generated Summary summation slots.

An added benefit of the enumeration of slots dependent on the
Summary summation slots is to explicitly represent the purpose of
those slots -- i.e. being part of a mass balance computation.

The arrow icon buttons move the set of selected items up or down
in the list.

The "Add..." button brings up the slot selector to pick slots to be
added to the list. The selector will be initialized to show only series
and scalar slots having Rpl expressions.

The "Remove" button will remove the selected items from the list,
after a confirmation by the user.

A context menu on this list will provide the following operations -- similar to those in the main tree view context menu:

Plot the selected slots.
Show the selected slots in Open Slot dialogs.
Show the selected slots in a new SCT.
Add the selected slots to an open SCT.

Note, however, that these slots can effectively be added only to SCTs showing series with the same timestep size.
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(2.7) Mass Balance Slot Group Configuration Dialog

The Mass Balance Slot Group Configuration dialog is shown modally when clicking the (Slot Group) "Configure..." button in the Mass Balance
Summary Dialog. This configuration dialog is used to define the set of Slot references which compose each of the Slot Groups within a Mass
Balance.

This dialog presents lists in four quadrants:

The top-left quadrant shows the currently selected Slot Group, its containing Water Balance, Water Balance Group and Mass Balance object
(data object). It also shows the selected Slot Group's sibling Slot Groups (contained within the same Water Balance). The user can navigate to
any of the sibling Slot Groups by clicking on its item -- if any un-applied changes to the selected Slot Group Slots list exist, a confirmation
popup is shown, allowing the user to (1) apply the changes, (2) discard the changes, (3) cancel (the change to the different Slot Group).
The top-right ("Object Filter") quadrant shows a list of simulation objects in the model from which slots can be chosen for inclusion in the
Water Balance's Slot Groups. The user can pick additional objects for this list with the "Add ..." button -- this brings up the GUS object
selector. The selected items can be removed from the list by clicking the "Remove" button. The "Select All" button selects all object items
and the "Invert" button inverts the selection.
The bottom-right ("Available Slots") quadrant shows the "available" relevant slots within the set of selected objects in the Object Filter list
which are not already used in the selected Slot Group -- or in any of the Water Balance's slot groups, depending on the "Show slots used in
other slot groups" checkbox.
The bottom-left ("Slot Group Slots") quadrant shows the Slot references in the selected Slot Group.

Slots can be moved between the bottom two quadrants (Slot Group Slots and Available Slots) with the large arrow buttons between those two
quadrants.

If no un-applied changes have been made to the Object Filter list (not including item selections) or the Slot Group Slots list, the OK and Apply
buttons are disabled, and the "Cancel" button is instead labeled "Close".

The "OK" button applies the not-yet-applied changes to the Mass Balance Summary configuration and dismisses the dialog.

The "Apply" button also applies the not-yet-applied changes to the Mass Balance Summary configuration, but does not dismiss the dialog.

The "Cancel" / "Close" button dismisses the dialog without applying additional changes to the Mass Balance Summary configuration.
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When applying changes, if any of the Water Balance's Slot Groups contain slots not on the simulation objects in the Object Filter, a warning is
shown, giving the user the option to (1) automatically add the missing objects to the Water Balance's Object Filter -- OR (2) ignore the condition OR
(3) cancel the "apply" (or "OK") operation.

(2.8) Series Slot Displays

The generated Summary summation slots will be viewable in the SCT and Open SeriesSlot Dialogs in the usual way. When using the special "show
in SCT" operations from the Mass Balance Summary dialog, divider items with text will be generated for the names of the containing higher-level
objects.

TBD: We'll need to decide how the SCT Slot Item labels are set -- i.e. whether they the primary names of the various items OR the names of the
generated slots (which use the configured abbreviations, when available). This might be done differently for the two axis orientations, and we might
decide to add user-settable preferences for how SCT Slot Item labels should be composed.

Possible Enhancement: Credit / Debit Slot Annotation ...

 

We could consider adding flags to Series Slots to indicate that the slot represents a "Credit" or "Debit", and enhance the Series Slot
Displays (SCT and Open SeriesSlot Dialog) to show a plus ("+") or minus ("-") with the slot label in the row or column header, something
like this ...
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(3) Development

(3.1) Required Internal RiverWare Enhancements

Slot Attribute Flag: Mass Balance Sum Slot

It will be important for the Mass Balance Summary mechanism to recognize slots which had been created for summary series. Such slots no longer
corresponding to series items in the configuration (related by user-defined names and abbreviations for those items) need to be removed. An easy
way to accomplish this is to add a "Mass Balance Sum Slot" Slot Attribute bit.

Slot Attribute Flag: Credit / Debit Slot Annotation (Optional)

Similarly flags could be added to support a Credit / Debit Slot Annotation (see prior section). Fundamentally, this needs three states which could be
represented with two attribute bits (in a couple distinct possible ways, TBD).

Default -- not a credit or debit1.
Is a credit2.
Is a debit3.

Additional Physical Slots

A "change in storage" entity was required for the URGWOM mass balance computation. This was done using Rpl expression slots (6 of them), and
still could be. But we could consider adding a FLOW slot on reservoirs to represent this entity.
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(3.2) Development Tasks

(3.2.1) Internal Data Model
(3.2.2) Retooling Mass Balance Summary Dialog "Mockup" for actual data model.
(3.2.3) Summary Computation
(3.2.4) Abstract Item-Model based implementation of the main QTreeView
(3.2.5) Display unit type (flow and volume) and unit conversions.
(3.2.6) Summary Configuration Editing Operations
(3.2.7) Revision of supporting QTreeWidgets to use the actual data model.
(3.2.8) Series Display Interfaces
(3.2.9) Integration / Finishing

(3.2.1) Internal Data Model

A Mass Balance Summary configuration will be an individually maintainable object, with a single optional index deployed on each data object. It
will be serialized using XML (implemented with the Qt4 QDom classes), and that serialization will be embedded in the data object (SimObj) Tcl
serialization.

The Mass Balance Summary data model will provide classes for lower-level objects, including a simple composite-pattern class hierarchy for the
four levels of collection items. Slot references will be represented with SlotColRefs (so that individual columns within, Table Series Slots could
potentially be supported).

Subtasks:

Basic C++ class definition and implementation1.
Maintenance of a Summary instance on Data Objects (with minor GUI operation implementation).2.
XML serialization and deployment in the SimObj Tcl serialization3.
Regeneration of the URGWOM reference model mockup data as an actual Model Balance Summary configuration instance.4.

(3.2.2) Retooling Mass Balance Summary Dialog "Mockup" for actual data model.

Much of the mockup implementation is functional, but operates on shallow mockup data derived from the URGWOM reference model. Recoding
the mockup implementation to operate on the real internal data model is a simple matter, and will support the development of the summary
computations.

This task will not include re-implementation of the item-based QTreeWidget as an abstract item model-based QTreeView.
This task will not include the development of edit operations on the Mass Balance Summary configuration.

(3.2.3) Summary Computation

Given an internal model implementation and a basic GUI to present the structure of the Summary configuration, the maintenance and computation of
the summation slots can be implemented.

Subtasks:

Add the "Mass Balance Sum Slot" slot attribute to the Slot class.1.
Maintenance (creation and culling) of Mass Balance Sum Slots on the Data Object.2.
Series sum computations.3.
Error checking and reporting.4.
Evaluation of Dependent RPL Expression Slots5.
Revise reference model's Dependent RPL Expression Slots (for annualization) to refer to generated sum slots.6.
Peformance testing with the full reference model (4000+ timesteps).7.

(3.2.4) Abstract Item-Model based implementation of the main QTreeView

The mockup implementation was based on an item-based QTreeWidget which has inherent peformance limitations. This will need a full Qt4 abstract
item model implementation with a custom delegate.

Subtasks:

Basic item-view model implementation for a 4-level QTreeView.1.
Abstract item model testing and debugging (using http://developer.qt.nokia.com/wiki/Model_Test).2.
Item expanded state, selection and scroll position persistence.3.
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Delegate: background colors.4.
Conditionally enabled incell editing of item names and abbreviations.5.

(3.2.5) Display unit type (flow and volume) and unit conversions.

Subtasks:

Saving Unit Type and Unit widget selections in data model. (Reference timestep date/time too).1.
Display value string computation and display.2.

(3.2.6) Summary Configuration Editing Operations

Item creation ("New") for the top-three levels.
"Copy" and "Paste" operations, with special internal "clipboard" support (only usable within a single RiverWare process).
"Delete" operations, with confirmation.
Slot Group Credit ("+") and Debit ("-") property assignments.

(3.2.7) Revision of supporting QTreeWidgets to use the actual data model.

The mockup implementations of the five minor display lists (with item-based QTreeWidgets) are fairly complete. These will remain QTreeWidgets
(i.e. abstract item-model based QTreeView implementations are not warranted). The mockup implementations need to be retooled to use the actual
data model.

Subtasks:

Dependent Expression Slots List
picking new Slots with GUSa.
moving selected items up and down.b.

1.

Slot Group Config Dialog Lists
Slot Groups Lista.
Object Filter / picking new Objects with GUSb.
Slot Group Slots Listc.
Available Slots Listd.

2.

Slot Group Config Dialog Completion3.
Used / Available transition button operationa.
Slot Group edit session maintenance (OK / Apply / Cancel) ...b.

(3.2.8) Series Display Interfaces

Plot selected items, automatic plot page configution.1.
Add Slots to SCT: automatic SCT slot divider and item configuration2.
TBD: Credit ("+") / Debit ("-") Slot Annotation: internal flag and GUI in Open Slot Dialog and SCT.3.

(3.2.9) Integration / Finishing

Open Data Object Dialog enhancements1.
Workspace Menu: Dynamic "Mass Balance Summary" dynamic submenu2.
Mass Balance Summary "recomputation time" analysis (based on performance) and implementation.3.

--- (end) ---
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